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1 Timeless Project Tracking
The time and expense tracking software that doesn't take all your time. 

· Would you like to make better and more accurate decisions about your time management? 
· Do you want to consistently be within your projected timeframe and budget when you give

estimates? 
· Are you 100% confident you're getting paid for all the work you do? Or is it possible you're

missing out on revenue opportunities because you don't have accurate time tracking? 

Whether you are tracking for time and billing or for project management, accurate time tracking is
important. There is a cost to pay for inaccurate time tracking. It might be a loss of billing income. It
might be in lost opportunity due to under utilized resources. It may even be in lost credibility. You
don't want to pay for any of those, especially if it's because you didn't have accurate time tracking
software. Use Timeless Project Tracking and make sure this doesn't happen. Timeless Project
Tracking gives you accurate information. 

But to get accurate information, your time tracking software has to be easy to setup and easy for
those doing the tracking. It has to be just as easy to track in detail as it is at a high level. If it isn't, you
won't get accurate information. Even if your software is easy to use, you won't get accurate
information by filling out your timesheet at the end of the period. You need to be able to record your
time as you work with as little interruption as possible. 

Timeless Project Tracking does all this, and it's easy because it works the way you do. It's
easy to set up. It tracks your time just as easily at a detailed level as at a general level. It is
also the time tracker that allows you to track your time without interruptions! 

Time and Billing
Timeless Project Tracking has the ability to bill at a variety of rates ensuring, once again, that you
capture accurate information. You can set billing rates at any level you choose, including client,
project, task or any of your custom defined levels. Additionally, billing rates can be set for a specific
employee, activity or combined with task levels. These features are easy to use but nearly invisible if
you don't need them, so Timeless Project Tracking is the time tracking software that stays easy to
use. 

Project Management
The first step of any project plan is to estimate the work required. You will find information that is right
for billing does not have the detail to accurately estimate future work. That's where the time tracker
features of Timeless Project Tracking benefits you! 

Timeless Project Tracking provides up to 20 custom defined levels so you can track time at the level
of detail you need. Try that with other tools that give you the standard client and task levels. With
Timeless Project Tracking's flexible reporting capability, you get the information needed to accurately
estimate time and costs on future tasks in addition to accurate billing information. It's easy to
summarize at any level to get the information you need when you need it. 

Of course, project management starts with a good plan, but it doesn't end there. Projects are
dynamic; they change over time. If you don't keep track of the project, it slowly gets out of date. Soon
you don't know where the project stands. You may miss opportunities to expand the project or worse,
the project is late and you didn't notice soon enough to do anything about it. With many levels of
detail, Timeless Project Tracking can track your project at the same level of detail as your project
plan. 
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2 Overview
Timeless Project Tracking is comprise of different work areas.  You will use the different work areas
to accomplish tasks within Timeless Project Tracking.

The main areas are:
Main Window
Work Items
Plan pane
Track pane
Status pane
Report pane
Invoice pane

2.1 Main Window

At the top is the main menu and the toolbar.  Both are used to initiate actions.

On the left side of the window are work items.  Work items are shown in the work item hierarchy on
the All panel.  Selected work items are shown on the Favorite and Recent lists.  Time off items are
displayed in their own panel.

The right side of the window contains the plan, track, status, report and invoice panes.  These panes
are where you work with and use work items.

2.2 Work Items

A work item is a Company, Client, Project, Task or any other work item type you define.  Work items
are created in a hierarchical structure that models your real work.  This structure makes it easy to
logically group and report on daily activities.  With a hierarchy of definable work items types you have
the flexibility to model the simplest or most complex business and projects.

Work items are the focus and starting point to most actions in Timeless Project Tracking.  Selecting a
work item is the first step to adding time, expense and to do entries, creating assignments, adding
notes, creating invoices, viewing status, and even adding new work items.

You can add work items individually using the Insert menu.  But if you want to quickly add many
work items, you should use the Enter Multiple Work Items toolbar button where you have the option
of entering assignments and estimates.

2.3 Plan pane

The plan pane is used to setup and configure work items.

Depending on your permissions, you may see all or some of tabs.  The general and notes tabs are
used to enter basic information about the work item.

In Personal mode the estimate tab is used to specify estimates for the work item.  Estimates are used
by the progress report, backlog report and status pane to track work items.

In Enterprise mode the assignment tab is used to assign the work item to employees.  Assignments
are used by the progress report, backlog report and status pane to track work items.
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In Enterprise mode with Work Item Security enabled, the permissions tab is used to set user
permissions on the work item.

The billing tab is used to define billing rates and define additional fixed cost items for invoicing.

2.4 Track pane

The track pane is used to create, view and modify time, expense and to do entries.  The timesheet
tab is used to enter an entire weeks of time at once.

The time, expense and to do tabs list entries for the selected work item or date depending on the
view selected on the View menu.

The columns of each list are customized by pressing the column chooser icon and dragging columns
to the list.  The time, expense and to do entries can be grouped and totaled by dragging select
columns to the grouping header.

2.5 Status pane

The status pane is where you track work item status and manage the status of your assignments.

You can view your status visually with you choice of graphs on the status dashboards.  Risks are
identified on the risks tab.  You can update the status or your assignments using the My Assignments
tab.

2.6 Report pane

The report pane is used to get summarized and detail information on your work items.

The built-in report tab contains reports pre-configured with the most common options.  Built-in reports
available vary be your user permissions.  When running the reports you may be prompted to select
dates, work item and users.  Some built-in reports can be used to create custom reports by right-
clicking the report and selecting Customize.

The custom reports tab contains the reports you created.  Custom reports have more options and
more fields than the built-in reports.  It will also list all custom reports others have shared with you.

Additional Cost Detail
The additional costs detail built-in report provides a list of additional costs based on the criteria
selected.  Additional costs can be grouped and filtered depending on the built-in report selected.

Administrative reports
Administrative reports are simple reports that show how Timeless Project Tracking has been
configured.  Administrative reports are only available to users with administrative permissions.

Backlog
The backlog built-in report shows how much time is remaining on assignments made to work items. 
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The report shows the time remaining over time so you can see how individual assignments are
progressing.

Billing detail
The billing detail report is a variation of the time detail report which contains common billing
information.  It is only available in the built-in reports but can be customized.  The entries can be
grouped by different fields with totals on each grouping change.

Billing Summary
The billing summary report provides summarized billing amount totals based on the criteria selected
for the report.  This report can be summarized by any work item type in addition to activity, task id or
user.  Different date ranges are used to create different billing amount buckets for each summarized
item.  Finally, totals are provided for each date and summarized item.

Expense Summary
The expense summary report provides a summarized totals of time based on the criteria selected for
the report.  This report can be summarized by any work item type in addition to expense types and
payment methods, and users.  Different date ranges are used to create different expense buckets for
each summarized item.  Finally, totals are provided for each date and summarized item.

Estimate Reports
The estimate built-in reports are used to track new and changed estimates.

Progress
The progress report provides a quick report of project status.  This report summarizes the total time
for work items which is used along with estimates and project assignments to show status.   This
report always reports on all dates

Time Detail
The time detail report provides a list of entries based on the criteria selected in the report properties. 
This report can be thought of as extension of the time details list.  Time entries can be grouped by
different fields with totals on each grouping change.

Time Off Summary
The time off summary report is a variation of the time summary report that contains only time off
items.  It is only available in the built-in reports but can be customized.

Time summary
The time summary report provides summarized totals of time based on the criteria selected in the
report properties.  This report can be summarized by any work item type in addition to activity and
user.  Different date ranges are used to create different time buckets for each summarized item. 
Finally, totals are provided for each date and summarized item.

Time & Expense Summary
The time and expense summary report provides summarized time and expense totals based on the
criteria selected in the report properties.  This report can be summarized by any work item type in
addition to user.  Different date ranges are used to create different time and expense buckets for
each summarized item.  Finally, totals are provided for each date and summarized item.

To Do Detail
The to do detail report provides a list of entries based on the criteria selected in the report properties. 
This report can be thought of as extension of the to do list.  More detail is provided and a wider range
of entries may be reported on.
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2.7 Invoice pane

The invoice pane is where you manage invoices for work items.

Invoices are listed for the selected work item.  New invoices can be created using the New button. 
Once invoices are posted, the entries for the invoice are locked.  They cannot be modified or
invoiced again unless the invoice is deleted.

When an invoice is selected payments are listed below.  Multiple payments may be added.
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3 Tutorial
This tutorial will show the features of Timeless Project Tracking.  It is broken up into four parts.  
Setup Wizard and Setup is for used to get Timeless Project Tracking ready to use.  The Basics will
get you up and running quickly.  Advanced Features will help you to get the most out of Timeless
Project Tracking.   Project Management Features will show you how to use Timeless Project Tracking
to manage your project .

3.1 Setup Wizard

After installing and opening Timeless Project Tracking Web, the Setup Wizard will guide you through
initial setup.  After completing this section you can to continue by adding the work items your team
will use to track their time, expenses and to do items.

3.1.1 Name

*Personal mode only

Timeless Project Tracking running in Personal mode requires your name.  The name may appear in
reports and will be used if you switch to Enterprise mode.

Enter your name and location press Next to continue.

3.1.2 Administrator Password

*Enterprise mode only

Timeless Project Tracking has a built-in administrator account for use in Enterprise mode. The user id
is TTEAdmin and is limited to basic administration such as creating users and assigning permissions.

Once logged in as TTEAdmin, a user can assign advanced permissions to any user or even delete
users and all data.  So it is very important to set a password on the TTEAdmin user account.

Enter a password you will remember and press Next to continue.

3.1.3 Company

Timeless Project Tracking uses a customizable hierarchy of Clients, Projects, Tasks, etc.  At the top
of the hierarchy is your company.  Since each item of the hierarchy can inherit from its parent, it is
easy to define items.  You only enter unique information.

To start the hierarchy, Timeless Project Tracking needs to know your company name.

Enter your company name and press Next to continue.

3.1.4 Users

*Enterprise mode only

Timeless Project Tracking uses a variety for permissions which limit what an individual user is
allowed to do.   During the trial, all functionality should be available. To make that happen, all
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permissions will be added to the user you create here.   Later, administrators can create additional
users and assign different permissions from the Tools | Users menu.

To add users, enter the name, user name and passwords, then press add.

Press Next to continue after adding at least one user.

3.1.5 Personal File Location

*Personal mode only

Timeless Project Tracking Once the initial information has been entered a new data file will be
created.  This data file will store the information you entered into Timeless Project Tracking.    

Enter a file name and location press Next to continue.

3.1.6 Wizard Finished

Timeless Project Tracking Once the wizard is complete you can start Timeless Project Tracking.  
However, there are common options you can set using the Advanced button.  You can configure the
common options now or later using the Tools | User Options menu item.

If you would like to see a sort tutorial on Timeless Project Tracking, leave the Show Tutorial box
checked.

Press Finished to continue.

3.2 Setup

This section is only for administrators when setting up Timeless Project Tracking.  Other users should
move on to the Basics after logging in.  After completing this section your team will be ready to start
tracking time, expense and to do items.

3.2.1 Adding Users

*Enterprise mode only

To allow others to use Timeless Project Tracking, you must first add users.  The default administrator
user (TTEAdmin) is only used for setup, but cannot be used to track time or expenses

There are many different kinds of users with different needs and requirements.  Some users need to
be able to run reports for other users, others should not be able to.  Some users need to be able to
add work items, while others shouldn't.  These different requirements can be set when creating users.

Logon as the built-in administrator TTEAdmin or another user with Administrator permissions. 

Because the default TTEAdmin user permissions are limited to adding users and basic maintenance
and cannot add entries or create reports, you will want a user capable of doing more.  To create a
user, select the Tools | Administration | Users menu item.  The Users dialog will open.  Select <
Add User > at the top of the user list.

Enter the Name as you would like it to display in Timeless Project Tracking.  Enter the User Name
this user will use to login.  Optionally, enter the email and password fields.

Switch to the Permissions tab to give this user specific permissions.



Tutorial 9

Copyright © 1997-2009 MAG Softwrx, Inc.

Note - Only Active users may log into Timeless Project Tracking and only Active users are required
to have a license.  If an employee leaves your company, you can uncheck the Active field and use
the license for a new user.  By setting the user inactive instead of deleting them, you keep all their
entries and can still report on them.

Press Save when finished.

Registered Users is the total licenses entered in the licenses screen.  If this count is not what you
expect, a  license number may have been entered incorrectly.
 
Active Users is the count of active users marked as active in Timeless Project Tracking.  Except
during the trial period, active users must be less than or equal to registered users.

3.2.2 Work Item Types

Work items types are used when adding work items as well as reporting.  Examples of work item
types include Company, Client, Project, Task, etc.  Defining you own work item types is optional.
You can use the types pre-configured with Timeless Project Tracking or change them later.

To add define or change work item types, select the Tools | Administration | Work item types
menu item.  To change the name or add a level, highlight the task level name or and unused level. 
Type the new name in the Name field.  If you would like to select a different icon, check the Use
Custom Image checkbox and select an icon.  Press Save.

Unused levels are named < Work Item Type ? >.  Unused levels are not available for adding new
work items.  This means the depth of the hierarchy is limited by the depth of named work item types

3.2.3 Adding Activities

Timeless Project Tracking allows time entries to be assigned to different activities.  Activities are
used to track specific types of work performed on work items.  The activities may be used later to
filter reports.   Defining you own activities is optional.

Before activities can be assigned, they must be defined.  To add define or change activities, select
the Tools | Administration | Activities menu item.

Select < Add Activity > at the top of the activity list.    Enter the new activity in the name field and
press Save.  

3.2.4 Adding Expense Types

Timeless Project Tracking allows expense entries to be assigned to different expense types. 
Expense Types are used to track what an expense was for.  The expense types may be used later to
filter reports.

Timeless Project Tracking comes pre-loaded with some common expense types.  Before expense
types can be assigned, they must be defined.  To add define or change expense types, select the 
Tools | Administration | Expense Types menu item.

Select < Add Expense Type > at the top of the activity list.    Enter the new expense type in the
name field.  If this expense type is charged per unit, such as mileage, check the Use Unit Rates and
enter a default per unit rate.  Press Save.  
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3.2.5 Adding Payment Methods

Timeless Project Tracking allows expense entries to be assigned to different payment methods. 
Payment Methods are used to track how an expense was paid.  The payment methods may be used
later to filter reports.

Before expense payment methods can be assigned, they must be defined.  To add define or change
payment methods, select the Tools | Administration | Payment Methods menu item.

Enter the name in the Name field.  Select the Account Type and optionally enter an account number. 
Press Save. 

3.2.6 System Settings

The systems setting are used to configure how Timeless Project Tracking operates.

General Tab

Allow Elapsed specifies if users may enter time in elapsed amount.  If elapsed entries are not
allowed user must enter start and end times or use the timer to create new time entries.  Additionally,
the timesheet can only be used to view weekly time if elapsed entries are not allowed.

Allow Overlap specifies if entries start and end times are allowed to overlap with other time entries.
If entries are not allowed to overlap you will be prompted when entries you enter overlap.

Round start and end time to nearest forces timer entries to round both the start and end times to
the nearest minutes.  Minutes are specified by each user in their User Options.

Always round time up forces the timer entries to round the total elapsed time up to the minutes
specified by each user in their User Options.

In personal mode your data file can be backed up automatically when closing Timeless Project
Tracking or at a specific time.  If backing up at a specific time, your data file is only backed up when
Timeless Project Tracking is active.

Invoice Options

Your Address is the default address on new invoices.  This can be changed on each invoice.

Default terms is the text included in the terms section of new invoices.  This can be changed on
each invoice.

Default tax rate is the tax rate assigned to new invoices.  This can be changed on each invoice.

Next number is the number that will be used for the next invoice.  This is incremented an invoice is
posted.

Planning

Project hours per day is used to convert estimates entered in days to an estimate in hours.  For
example: if project hours per day is 6, an estimate entered as 5d will be converted to 30 hours
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(30:00).

Security

Enable Work Item Security 
Work item security is an advanced feature that is not required to use Timeless Project Tracking.  This
feature may be enabled later and it is recommended you do not enable this feature until you've
become familiar with all other aspects of Timeless Project Tracking.

Work item security allows you to specify which work items individual users have access to.  The
users will only be able to create entries for the work items they have been given access to.  Users
who have permission to Maintain Work Items, will only be able to modify the work items they have
access to.  If a user has been given access to a work item, they will also have access to child work
items unless permission is denied on those child work items.

To enable Work Item Security select Tools | Administration | System Settings menu item.  On the
Security tab, select Enable Work Item Security.

Note: For users to see the new tasks they have been assigned to, they will have to refresh their
browser window.

3.3 The Basics

The items contained in basics are items you should know.  After this tutorial section you will be able
to start tracking your project.

3.3.1 Logging in

*Enterprise mode only

To start using Timeless Project Tracking in Enterprise mode, you must first log in.  Enter the user id
and password provided by your administrator and press Login.

3.3.2 Adding Work Items

The first step to accurately tracking time and expenses is creating a work item hierarchy that reflects
your real world situation.  To accomplish this, you must be logged in as a user who has the Maintain
Work Item permission.

Timeless Project Tracking allows you to create work items in two ways.  Work items may be created
individually or an entire branch may be created at once. 

Adding one work item  

Select New Client (or other work item type) from the Insert menu.  Timeless Project Tracking
switches to the planning pane so you can enter the name of the new work item.  To create a new item
at the top of the work item hierarchy, select a menu item from the Insert | New Top Work Item
menu.

Adding multiple work items
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To add more than one work item to the hierarchy at once, press the Enter Multiple Work Items
toolbar button.  The Add multiple work items window opens and positions the cursor on the first item.
 

Enter the name of the first work item.  Press tab to move to the optional fields to create assignments
and estimates.  When you tab past the last field, a new line will be added.

Work item types may be changed by pressing the indent and outdent toolbar buttons.  Work items
may be moved up and down by using the up and down toolbar buttons.

If you would like to subtract the amounts of new estimates from the parent of the new work items,
check the Subtract estimates from parent work items box.  This is useful when you are adding
work items to refine a project plan where estimates have already been made.

3.3.3 Adding Time Entries

Timeless Project Tracking tracks time entered by associating time entries with work items.  At a
minimum, a time entry requires a start and end time or the elapsed time.  Optionally, an activity, note
and entry specific billing information may be entered.

To add a time entry, first select a work item.  Next, select New Time Entry from the Insert menu.
Enter a start time and an end time.  Optionally, tab to the other fields to enter optional information. 
Press Save.

Time entries may also be entered by pressing the New Time Entry toolbar button or by dragging a
task to the time entry list of the track pane.

3.3.4 Starting Time Entries

Timeless Project Tracking can track by using timers.  This reduces the amount of effort needed when
changing tasks.  A timer may be stopped and a new one started with one mouse click.

To start a timer, select a work item and select Start Timer from the Edit menu.  If another entry is
running, it will be stopped automatically when starting the new timer.  Additionally, a time entry can
be started by pressing Ctrl-G or pressing the Start Time Entry toolbar button.

If you would like to the opportunity to modify each timer entry, you can easily do it by changing your
User Options to Display time entry when starting timer or to Display time entry when stopping
timer.  This makes it easy to add a note or select an activity.

3.3.5 Adding Expense Entries

Timeless Project Tracking tracks expenses entered by associating expense entries with different
tasks.  Expenses may be categorized by expense type and payment method.

To add an expense entry, first select the Expense tab of the track pane.  To add a expense entry,
first select a work item and then select New Expense Entry from the Insert menu.  Select an
expense type and enter and expense amount.  Press Save.  If the expense type selected is charged
per unit, enter the units and optionally change the per unit rate.

Expense entries may also be entered by pressing the New Expense Entry toolbar button or by
dragging a work item to the expense entry list of the track pane.
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3.3.6 Adding To Do Entries

Timeless Project Tracking tracks items you need to do by associating then with different tasks.  At a
minimum, a to do entry requires a description.  Optionally, a priority, due date, complete date and
note may be entered.

To add an expense entry, first select the To do tab of the track pane.  To add a to do entry, first
select a work item and then select New Expense Entry from the Insert menu.  Enter a description
and optionally other fields.  Press Save.

To do entries may also be entered by pressing the New To Do Entry toolbar button or by dragging a
work item to the  to do entry list of the track pane.

3.3.7 Using the Timesheet

In addition to detailed time tracking, Timeless Project Tracking has a timesheet to easily enter time in
bulk without detailed time entries.  The timesheet can also be used as a quick summary of time for a
week.  The timesheet shows daily totals for each task during the week, but also includes blank lines
for work items used in previous weeks.  

Switch to the timesheet view by clicking the Timesheet tab of the track pane.  Add a new line to the
timesheet by dragging a work item to the timesheet.  Enter hours for each day and press Save.

Work items may also be added to the timesheet by selecting the work item and pressing the Add
new timesheet row toolbar button.

3.3.8 Editing Work Items

After a work item has been created, additional details can be entered to be used in other parts of
Timeless Project Tracking.

Select a work item and select the plan pane.

General 

The general tab contains the basic information about the work item including name, type and contact
information.  Name, abbreviation and task id are used to identify the work item.  The type is used to
identify the work item type and for reporting.

Task id and contact may be entered specifically for the work item or it may be the same as the parent
item in the hierarchy.

Notes

Notes are used to communicate information to others or just to keep track of details about a work
item.  In enterprise mode a user must have permissions to add work item notes.

Assignments

In Enterprise mode the assignment tab is used to assign the work item to employees.

Assignments are made for users or user groups to track the progress of the work item by using the
progress report, backlog report and status pane.  Assignments are shown on the to do tab of the
planning pane for the assigned user.
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Estimate

In Personal mode the estimate tab is used to specify estimates for the work item the progress of the
work item by using the progress report, backlog report and status pane.  When you add an estimate
and assignment is shown on the to do tab of the planning pane.

Permissions

When work item security has been enabled in the System Settings the permissions tab is available to
grant or deny  access or extended permissions to the work item to users and user groups.

Permissions for work items are inherited by parent work items unless changed on the work item. 
Inherited permissions are displayed at the top and can be easily changed by clicking the associated
link.

Billing

The billing tab is used to specify billing rates and add additional costs for a work item. 

Billing rate sets are created to define the billing rates for a range of dates.  Each billing rate set can
have a different currency for reports and invoices.  Each rate set must define the default user rate by
clicking the edit link after defining the rate set.  Rates may also be specified for individual users by
adding additional user rates.  Rates may be specified by activity for any user rate.

Additional cost items are used for fixed costs.  They can be included on invoices and on the status
dashboard.

3.3.9 Editing Existing Entries

After a time, expense or to do entry has been created its details can be edited.

Highlight an entry and select Properties from the Edit menu.  Double clicking an entry or using the
Properties toolbar  button will also display the properties.

3.3.10 Complete and Assignment or To Do Entry

Timeless Project Tracking will easily complete an outstanding assignment or to do entry.

Select an assignment or to do select Complete from the Edit menu.  The entry will be completed on
the day selected on the calendar.  Completing and assignment will be reflected in the progress report,
backlog report and status pane.

You may also use the popup menu by right-clicking on the Assignment or To Do entry.

3.3.11 Adding a Work Item to Favorites

Timeless Project Tracking has a Favorite list so you can easily work with common work items.

To add a work item to your favorites list, highlight the work item in the task hierarchy and select the 
Favorites | Add to Favorites menu item.
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3.3.12 Purchasing Timeless Project Tracking

You are free to use Timeless Project Tracking for 30 days to see if it fits your needs.  To continue
using after thirty days, you will be required to purchase Timeless Project Tracking.  Shortly after, you
will receive a license number that will eliminate unregistered  messages and continue adding entries
after 30 days. 

To enter your license number, select the Tools | Administration | License and enter your name and
license number exactly as the appear on the registration confirmation you received from MAG
Softwrx, Inc.  

3.4 Advanced Features

The items in this section will increase your knowledge of the smaller details of Timeless Project
Tracking.  They will make common and uncommon tasks easier.

3.4.1 Using Builtin Reports

Built-in reports provide quick access to the most common report options without creating a custom
report.

Select the Built-in tab for the report pane.  Find and expand the report type you would like.  Expand
until you find the report options you need.  Double-click the report to run it.  Most reports require
additional input of date, work item and/or user.

Some report can be used as a starting point of a custom report.  Right-click the built-in report you
would like to customize and select the Customize menu item.

3.4.2 Creating Custom Reports

After entering information, it is important to be able to display the right amount of information.  With
Timeless Project Tracking, a variety of filters are used to display just the level of detail needed.

A report wizard is used to create a report quickly and easily.  The options presented vary by the
report type selected.-

Custom reports, like built-in reports are templates that always contain the most current information
whenever they are run.  Custom reports may be shared with other users if you have required 
permissions.

3.4.3 Report Options

The report options are used to specify the data used to generate the report as well as the layout.  The
options available are dependent on the report type, user permissions and installation mode.

Type
When creating a report the first choice it the type of report.  The report type controls the other report
options.

Dates
A report may use specific dates, a time frame or prompting for different dates to filter the data when
the report is run.  
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Time frames can be used to make reports more reusable.  When using a time frame, each time the
report is run the dates used will be calculated by applying the time frame from the current date.   For
example: if you are required to submit a time report on the first of the month for the previous month,
you can use the "Previous Month" time frame.  Every time you view this report, it will show the
previous month.

With Prompt for Dates you will be prompted to enter the dates each time the report is run.

Users
A report can be run for All, Current user or Selected users or user groups.  To run a report of All or
Selected users you must have the Create Multiuser Report permission.

Work items
A report may include All or selected work items.  Some reports have the option to include only the
selected work items or to include the child work items of selected items.

Time reports may be additionally filtered to include billable entries, non-billable entries, work time or
time off.

To do reports may be additionally filtered to include completed or outstanding entries. 

Activities
Time reports may be filtered to include All or Selected activities.  Only time entries having a selected
activity will be included in the report.

Expense Types
Expense reports may be filtered to include All or Selected expense types.  Only expense entries
having a selected expense type will be included in the report.

Payment Methods
Expense reports may be filtered to include All or Selected payment methods.  Only expense entries
having a selected payment method will be included in the report.

Grouping
Detail reports are grouped by one field with totals displayed for each value.

Summarize
Summary reports total entries into date buckets for one or two summary items.  The date summary
can by day, week, month or total.  The summary items can be items such as work item type, user,
activity, expense type, etc. depending on report type.  

Totals and empty rows may be included or excluded.  Entries may be rolled up to parent items so that
values for date buckets include the item and all child items.

Display Fields
Most reports offer a choice of additional fields to display.  Use the arrows, up and down to add,
remove and order the fields in the report.  

Fields in detail reports may distributed one more than one line by adding line breaks.  Layout may be
adjusted by adding empty cells.

Options
You can change the look of the report by changing the page orientation and font. Select an optional
image to include as a logo at the top of your report.  Only images placed in the /logos folder of the
web installation will be available.
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Share
In Enterprise mode, users with Share reports permissions may share a report with other users or
user groups.  A report shared may only be modified by the report owner.  The report owner or the
built-in administrator may change the report owner by right-clicking the report and selecting the
Change owner menu item.

Name
Each report must have a name.  Once the report has been created, the name may be changed using
the Edit | Rename menu item.

3.4.4 Task Tray

Timeless Project Tracking integrates with the windows task tray to simplify starting task timers.  You
can easily start timers on items on your favorite and recent work item lists while Timeless Project
Tracking minimized on your desktop.  This minimizes the interruptions to normal work flow, which
makes time tracking easier and more natural.

To start a timer from the task tray, right click on the Timeless Project Tracking icon on the task tray. 
Select the recent or favorite work item.

3.4.5 View Entries By Task

When trying to find when certain work was done or an expense was incurred on a work item, it is not
necessary to run detail reports to find a particular entry.  Timeless Project Tracking allows you to view
all entries for a work item, no matter when they occurred.

To view by task, select Work Item from the View menu.  To switch back, select Date from the View
menu.  Timeless Project Tracking also provides toolbar buttons to change the view.

3.4.6 Moving Work Items

Sometimes you will need to reorganize work item task hierarchy.  With Timeless Project Tracking you
can move work items around without effecting existing reports or time, expense and to do entries.

Click down on the work item to move.  Drag the work item to a new parent task.  Any child work items
will also be moved.

When moving work items, you have to keep work items in a descending hierarchy.  This means you
may have to change the work item types of work items before moving or allow Timeless Project
Tracking to automatically change the work item  types of the moved items.

3.4.7 Copying Work Items

In some work environments many clients or projects have similar work item hierarchies.  For this
case a work item hierarchy may be copied from one item to another.

Click down on the work item to copy.  Hold the CTRL key and drag the work item to a new parent
work item.  Any child work items will also be copied, including billing rate information. User specific
information such as permissions and assignments will also be copied. Time, Expense and To Do
entries will not be copied.

When copying work items, you have to keep work items in a descending hierarchy.  This means you
may have to change the work item types before copying or allow Timeless Project Tracking to
automatically change the work item type of the copied items.
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3.4.8 Moving Entries

Sometimes entries are added to the wrong work item or day -or- one work item needs to be broken
out into multiple work items.  With Timeless Project Tracking you can move entries around without
affecting the information in them.

To move an entry to a new work item, click down on the entry to move.  Drag the entry to a new
parent work item.  When separating an existing work item into multiple new work items, it is helpful
to view entries by task.

3.4.9 Copying Entries

Sometimes entries are similar from day to day.  With Timeless Project Tracking, you can copy
existing entries from one day to another.

To copy entries to a new day, select the entries to copy, then drag to the new day on the calendar
while holding down the CTRL key.  The selected entries, except running entries, will be copied to the
new day.

Copying entries is only available in the Windows version of Timeless Project Tracking.

3.4.10 Rounding Timer Entries

Timeless Project Tracking will round timer entries to 1, 3, 5, 6, 10, 15, 30 or 60 minute intervals.

To change the rounding interval used, go to the time entry options by selecting User Options from the
Tools menu.  Select the Time Entries tab and change the Round to Nearest selection.

Timeless Project Tracking will round entries based on the selection in the System Settings.

3.4.11 Elapsed Time Format

Timeless Project Tracking will display elapsed time on reports and time entries in either time or
decimal format.

To change the elapsed time format, go to the time entry options by selecting User Options from the
Tools menu.  Select the Time Entries tab and change the Time Format selection in the Show
Elapsed Time As section.

3.4.12 Automatically Displaying Time Entry Properties

Timeless Project Tracking will automatically display a time entry's properties when starting and/or
stopping the timer.  This is useful for capturing activities and notes associated with a time entry when
the event occurs.

To enable the automatic display of time entry properties, go to the time entry options by selecting
User Options from the Tools menu.  Check the boxes to display the time properties when desired.

3.4.13 Adjusting Overlapping Time Entries

Timeless Project Tracking will assist you in correcting overlapping entries.  If you create a new time
entry that overlaps another, you will be given the option of how to correct the overlap.
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For example, lets say you have a time entry from  8:00 - 10:00 and you create a new time entry that
goes from 9:00 - 11:00.  This will overlap the existing entry.   When saving the entry, you will be
prompted how to adjust other time entries.  When choosing to adjust existing entries, the first entry
will be automatically adjusted to end at 9:00.

This is especially useful when you forget to start a timer.  By adjusting the start time of the running
entry, you can correct both entries at once.

You can allow overlapping entries by changing the system settings.  If you allow overlapping entries
you will not be prompted to adjust the entry.

3.4.14 Adding Entries from Existing Entries

With Timeless Project Tracking, you can add new entries from existing entries.  This allows you to
add entries quickly for the work  items you have used recently.

Right click on a time entry and select New Time Entry.  Regardless of the work item selected in the
work item hierarchy, the new time entry will be created for the work item of the selected time entry.

3.4.15 Drag Work Item to Create Entries

Entries may also be created by dragging a work items to the time, expense or to do entry list.

Select the tab of the desired entry.  Select and drag a work item to the list.

You can add a new row to the timesheet by dragging the work item to the timesheet.

3.4.16 Deleting Work Items

Sometimes when reorganizing or consolidating the work item structure you will want to delete work
items.  Timeless Project Tracking will allow you to delete a work items and will optionally move all
existing entries to the deleted item's parent item.

Select a work item.  Select Delete from the Edit menu or press the Delete toolbar item.  Confirm that
you want to delete the work item.  When are asked if you would like to rollup entries, answer Yes.

3.4.17 Quick Detail Reports

When you need to print the entries displayed in the current view, Quick Detail Reports do it for you
without creating a report.  Time, Expense or To Do entries may be printed from either Date or Task
View.

With the desired entry list displayed, select Print or Print Preview from the File menu or use the
toolbar buttons.

3.4.18 Export Report Data

Often times it is valuable to be able to export data from Timeless Project Tracking for analysis in
another tool.  Timeless Project Tracking exports in some simple, widely used formats.

To export data, select or create a report that has the data you need.  Highlight the report and select 
Export Report Data from the File menu.
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CSV
Exported items are separated by your regional list separator and text values are enclosed in quotes.
Elapsed Time is formatted as selected on Elapsed Time Format option.
A Header row is included which defines each column's content.

TAB
Exported items are separated by Tabs.
Elapsed Time is formatted as selected on Elapsed Time Format option.
A Header row is included which defines each column's content.

HTML
The export is rendered as close to print format as possible using HTML.
You may customize the style of the elements by including a CSS file called timeless.css in the same
folder where the export is saved.
Images are embedded to preserve the look over time.  However, Internet Explorer 6 cannot display
embedded images.  If you use IE6, you can show your custom logos by copying them to the same
folder where the export is saved.

3.4.19 Adding User Groups

Timeless Project Tracking lets you create groups of users to use in assignments, permissions and
reports.

Before user groups can be used, they must be defined.  To add define or change user groups, select
the Tools | Administration | User Groups menu item.

Select < Add User Group > at the top of the user group list.    Enter the new user group in the name
field.  Select users and press Save.  

3.4.20 Adding Assignments

In Enterprise mode the assignment tab is used to assign the work item to employees.

Assignments are made for users or user groups to track the progress of the work item by using the
progress report, backlog report and status pane.  Assignments are shown on the to do tab of the
planning pane for the assigned user.

Assignments consist of a user or user group, time estimate, cost estimate, priority, due date and note.
 All fields are optional except user or user group.  However, it can be assigned to Anyone.

The more information provided the more valuable the information you receive when tracking your
project using the dashboard and risks.

3.4.21 Managing Invoices

Invoices are created for work items and are used to bill clients and record payments.  

Select a work item to manage the invoices for that work item.

Creating Invoices
Create a new invoice by pressing the New button below the invoice list.  Invoices can include billing,
expenses and additional cost items.  Each may included on the invoice summarized or as details of
each item. 

When summarizing, each type of item is summarized by the same dates, but each may be
summarized in different ways.  For example, billing may be summarized by project and expenses



Tutorial 21

Copyright © 1997-2009 MAG Softwrx, Inc.

summarized by expense type.  

Taxes may be applied to billing, expenses or additional costs.

Each invoice has its own sender, recipient, number, terms, font and logo choices.

Posting Invoices
Posting an invoice locks the time entries, expense entries and additional cost items used in the
invoice.  After posting, payment may be recorded against the invoice.

Recording Payments
To add a payment press the New button below the payment list.

3.4.22 Favorite List

The Favorite List allows you to quickly work with a task item without finding it in the work item
hierarchy.  The items on the Favorite List work just like the items in the Work Item Hierarchy.

You can add items to the favorites list by selecting a work item and using the Favorites | Add to
Favorites menu item.  You can manage your favorites by selecting the favorite and using the
Favorites menu.

3.4.23 Recent List

The Recent List allows you to quickly work with a recently used task item without finding it in the work
item hierarchy.  The items on the Recent List work just like the items in the Work Item Hierarchy.

You can manage change the order and number of items on the recent list in your user options.

3.4.24 Contacts

Timeless Project Tracking allows contacts to be created and associated with work items.

Before contact can be used, they must be defined.  To add define or change activities, select the 
Tools | Administration | Contacts menu item.

Select < Add Contact > at the top of the activity list.    Enter the new contact in the name field and
press Save.  

3.4.25 Adding Reminders

Reminders may be added to work item, time entries, expense entries, to do entries and assignments.

To add a reminder to an item, select the item and use the Edit | Reminder menu item or the
Reminder toolbar button.  Enter the date and time to be reminded and optionally a note.

When the reminder time is reached, the reminders window will be shown automatically.  The
reminder can then be snoozed or dismissed.  

A timer can be started on the selected item.  When starting a timer the reminder is dismissed.

If the reminder is on a to do entry or an assignment, the to do or assignment item can be completed

3.4.26 User Options

There are a few user options that control the behavior of Timeless Project Tracking.

General
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The number of work items on the and the order of the work items on the recent list can be changed
here.

You may change the day of the week your work week starts on.  This will affect the timesheet, reports
and calendars.

Time Entries
The elapsed time can be shown in time or decimal format.

The timer can be rounded to a number of minutes.

The time entry can be displayed when starting or stopping a timer for easy entry of additional
information.

The timer can be automatically stopped at a specific time.

When creating new entries activity and note can be set to the value of the last time entry for the work
item on the new time entry.

Status
The display of some items on the risks tab can be configure.  Items deviating from estimates can be
hidden completely or only shown if they exceed a specified variance.

Warnings predicting that an assignment will not complete on time or exceed the cost estimate can be
configured as to how aggressively Timeless Project Tracking predicts the missed due date or cost
estimate.

In enterprise mode, you can choose to hide work items assigned to Anyone in your work lists.  This
will hide these assignments in My Assignments of the status pane and the To Do list of the track pane
.

Performance
You can show or hide elements of the Timeless Project Tracking Web interface.  These elements
enhance the user experience but increase the time taken to perform actions.  You may want to hide
some items if you have a slow connection or are geographically far from the web server running
Timeless Project Tracking.

3.4.27 User Permissions

The user permissions available in Timeless Project Tracking are: 
Add Work Item Notes - the user can add and edit notes on work items.
Administrator - maintain Users and Task Levels, and run database maintenance operations.
Create Multiuser Reports - create and run reports with multiple users.
Maintain Activities - maintain activities used on time entries.
Maintain Billing Information - maintain task billing information
Maintain Contacts - maintain contact information
Maintain Expense Types - maintain expense types used on expense entries
Maintain Payment Methods - maintain payment methods used on expense entries.
Maintain Work Items - Create, modify and edit tasks.
Maintain Invoices - create invoices and apply payments
Share Reports - create reports that can be used by everyone
Update Assigned Cost Estimates - update cost estimates for user's assignments
Update Assigned Time Estimates - update time estimates for user's assignments
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View Billing Information - view billing information including on reports
View Full Status - view all users status on dashboard and risks

3.4.28 Set Billing Rates

The billing tab or the plan pane is where billing rates are defined for work items.  Billing rates are
used by all child work items unless rates are set for the child work items.

Billing Rate Sets are defined by date.  Any time entry for the work item within the date range will use
the billing rate set.  Each billing rate set may be assigned a currency.  This currency will be used for
whenever the rate set is used.  This includes time entries, expense entries and additional cost items.

Each billing rate has a Default User Rate.  The default user rate is used for time entries.  For this
reason, you must edit the default user rate when you create a new rate set.  In addition to the user
rate, you may optionally define different rates for specific activities.  The activity rate will be used for
time entries who activity match the activity rate.

In Enterprise mode rates may be defined for specific users.  The allows you to bill different rates for
different employees.

Additional Cost Items are fixed costs associated with a work item.  Fixed costs may be included on
invoices.  Fixed costs may also be used on the status dashboard to compare against actual costs.

3.4.29 Custom Fields

Expense entries, time entries, to do entries, users and work items may have custom fields.

Custom fields may be text, yes or no, integer, decimal or a list of choices.  Custom fields may be
included in reports or in entry lists.  Decimal and integer fields can optionally have minimum and
maximum values and be totaled on reports.

3.4.30 Required Fields

When creating assignments, expense entries, time entries, to do entries, users or work items, specific
fields can be required.  Required fields can include custom fields.

 Select the fields to require by checking the boxes and press Save.  Only administrators may change
the required fields. 

3.5 Project Management Features

Timeless Project Tracking includes a status pane to help you manage your projects, risks and
assignments

Using the Dashboard
Viewing Risks
My Assignments

Timeless Project Tracking Web integrates with MS Project 2002/2003/2007 through the use the
Windows interface.  Both versions work together by sharing the same database.  For details please
visit http://www.magsoftwrx.com.
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3.5.1 Using the Dashboard

The dashboard is a quick way of seeing project status.

Depending on your permissions, you have the choice of up to 90 different charts and graphs to on the
dashboard.  You can choose dashboard items to show for all work items and additionally set
dashboard items on specific work items.

Dashboard items can show status for a single work item of the selected branch of the work item
hierarchy.  If a dashboard item has "with Children" in the title, it will show the status for the selected
branch of the work item hierarchy.  If it does not say "with Children" it will show the status for only the
selected work item.  An exception to this rule are the Burndown status items.  Burndown items
always show the selected branch of the work item hierarchy.

Dashboard items can show the status for All Users or just the Current User.  Only those users with 
View Full Status permissions can see the status of other users.

Note:  Some dashboard item require assignments and/or estimates to display information.  These
include Burndown and Estimate items.

Dashboard item descriptions

Billing - Line chart of billing amounts over time.

Billing and Expense Vs Additional Costs - Line chart comparing the total of Billing and Expense
vs additional costs over time.  This is useful on fixed bid projects where the additional costs are the
fixed amounts billed and the billing and expenses are the actual costs of the project.

Billing Summary - Bar chart showing total billing amount for the work item, and the total for last 30
days, 7 days and current day.

Billing Summary by User - Bar chart showing total billing amount by user.

Billing Summary by Work Item - Bar chart showing total billing amount by work item.

Billing Amount Vs Additional Costs - Line chart comparing the total of Billing Amount vs additional
costs over time.  This is useful on fixed bid projects where the additional costs are the fixed amounts
billed and the billing is the actual cost of the project.

Burndown - Line chart showing estimate of time remaining for the work item over time.  The
burndown uses actual time, estimate and complete information to estimate the time remaining.

Burndown Projected - Line chart showing estimate of time remaining over time with future
projection.

Burndown Vs Actual Time - Line charts comparing Burndown and Actual Time.  The is useful to
compare how the project is progressing compared to the effort.

Cost - Line chart showing the total of billing, expense and additional costs over time.

Cost Estimate Vs Actual - Line chart comparing the total of billing, expense and additional vs cost
estimate over time.  This is useful to track how actual costs compare to the cost estimate.

Cost Summary - Bar chart showing total of billing, expense and additional costs for the work item,
and the total for last 30 days, 7 days and current day. 
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Cost Summary by User - Bar chart showing of billing and expense by user.

Cost Summary by Work Item - Bar chart showing total of billing, expense and additional costs by
work item.

Cumulative Billing - Line chart showing the cumulative billing amount over time.

Cumulative Cost - Line chart showing the cumulative of billing, expense and additional costs over
time.

Cumulative Expense - Line chart showing the cumulative expenses amount over time.

Cumulative Time - Line chart showing the cumulative time over time.

Expense - Line chart of expense amounts over time.

Expense Summary - Bar chart showing total expenses for the work item, and the total for last 30
days, 7 days and current day.

Expense Summary by Expense Type - Bar chart showing total expenses by expense type.

Expense Summary by User - Bar chart showing total expenses by user.

Expense Summary by Work Item - Bar chart showing total expenses by work item.

Time - Line chart of time over time.

Time Estimate Vs Actual - Line chart comparing the time total vs time estimate over time.  This is
useful to track how actual work compares to the estimated work.

Time Summary - Bar chart showing total time for the work item, and the total for last 30 days, 7 days
and current day.

Time Summary by Activity - Bar chart showing total time by activity.

Time Summary by User - Bar chart showing total time by user.

Time Summary by Work Item - Bar chart showing total time by work item.

3.5.2 Viewing Risks

The risks tab helps you proactively identify risks to your project.

Risks are shown for the selected branch of the work item hierarchy.  If you have View Full Status
permissions, you will see risks for all users and user groups.  You may filter the risks displayed by
minimum severity and when the risk was identified.

The display of certain types of risks may be configured in your User Options.

To receive the most useful information you should create assignment and estimates for work items.
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3.5.3 My Assignments

My Assignments where an individuals can quickly update the status of their assignments.

The list shows all incomplete assignments for the selected branch of the work item hierarchy. 
Assignment can mark as complete and estimates updated, if allowed by user permissions.  

When updating estimates a reason for the change can be added.  Changes estimates, reasons and
complete status are reflected in the dashboard and risks.

By updating assignments regularly, time spent in status meetings can be reduced or eliminated.

3.5.4 Adding a Project

Timeless Project Tracking can integrate with project management software to create task hierarchies.
Time and Expenses can be updated from entries entered into Timeless Project Tracking, simplifying
project tracking.

Select the work item you would like to be the parent of the imported project.  Select the Tools |
External Project | Import menu item.  Next, select the project file to import.

When adding a project the resources in the project are associated with users or user groups in
Timeless Project Tracking.

Work items will be created to match the project hierarchy.  Assignments will be created work items
with resources assigned in the project plan.

3.5.5 Updating a Project

By updating you project, Timeless Project Tracking can keep your work item hierarchy up to date with
your project.  Your project time and costs and even estimates can be updated in your project plan
provided.

Select the top work item in Timeless Project Tracking from your project plan.  Select the Tools |
External Project | Update menu item.

The options to update your project are presented in the Update Project window.  The options
available depend on the project plan.  Each item selected will be updated from Timeless Project
Tracking to the project plan.

Reminders may be added to each assignment imported to Timeless Project Tracking from the project
plan.  The reminders will be created for the users associated with the resources in the project plan.

3.5.6 Completing a Project Task

Timeless Project Tracking can also mark the work item as complete in your project plan.

Select an assignment on the to do tab of the track pane.  Select Complete from the Edit menu.  The
next time work is updated in the project, the entry will be marked as complete.

3.5.7 Unassigned Tasks

Occasionally, you may need to log time to a project task that you have not been assigned to. 
Timeless Project Tracking will still update the project with work.
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To ensure good project planning, you may want to add an estimate for the task in Timeless Project
Tracking.  The estimate will be updated in your project when you update the project.

3.5.8 Removing a Project

After a project is complete, you can remove the link to the project but keep all the work items and
entries.

Select the top work item in Timeless Project Tracking from your project plan.  Select the Tools |
External Project | Remove menu item.

Once the project has been deleted, you can delete work items as you normally would, if needed.
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